Migrasi Domain span.depkeu.go.id Ke Domain kemenkeu.go.id

Sehubungan dengan adanya permasalahan blue screen dan restart berulang kali pada

komputer SPAN, perlu melakukan update windows komputer SPAN. Agar dapat melakukan

update, komputer perlu melakukan migrasi domain dari span.depkeu.go.id ke kemenkeu.go.id.

Adapun langkah-langkahnya adalah sebagai berikut:

Login ke komputer SPAN dengan menggunakan akun domain SPAN yang biasa digunakan.
Buat folder baru (misalnya “folder backup”) di drive C:/.

Salin folder-folder yang ingin di-backup dari folder “C:/Users/<nama akun span
(contoh:001.kakantor) yang digunakan untuk login>" ke folder yang dibuat dilangkah satu.
Folder yang ada di “C:/users/<nama akun SPAN>" tidak dapat dibuka lagi jika sudah login
dengan akun domain. Biasanya, folder yang sering digunakan untuk menyimpan file adalah
folder Document, Desktop, dan Download.

4. Tutup seluruh aplikasi yang berjalan kemudian log off dari komputer.

10.

11.
12.

Pada layar login windows, tekan tombol “Switch User” kemudian login ke komputer SPAN
dengan akun:

Nama akun : \pcspan

Kata sandi : 1g2w3e!lQ@WHE

Lakukan penggantian domain komputer SPAN dari span.depkeu.go.id ke kemenkeu.go.id
dengan langkah sebagaimana dapat dilihat di lampiran 1.

Setelah komputer ganti domain dan restart, login kembali dengan akun kemenkeu pegawai
yang menggunakan komputer SPAN tersebut. Jika ingin mengakses komputer yang ada di
personal folder user sebelumnya, dapat mengakses folder yang dibuat pada langkah 2.
Setting Internet explorer, dan java dengan panduan sebagaimana dapat dilihat pada
lampiran 2.

Buka aplikasi adobe reader maupun Adobe Standar. Setujui licence agreement yang
muncul agar nantinya laporan berjenis file PDF dari aplikasi SPAN dapat ditampilkan.
Setting Microsoft excel 2010 agar dapat menggunakan fitur WebADI dengn cara
sebagaimana dapat dilihat pada lampiran 3.

Jalankan update windows dengan cara sebagaimana dapat dilihat pada lampiran 4.

Jika masih mengalami kendala, dapat menghubungi layanan HAI DJPb.



Lampiran 1: Panduan Pemindahan Domain Komputer SPAN Ke Domain
Kemenkeu.go.id

1. Buka “System” dengan menekan tombol “Start” -> klik kanan “Computer” dan kemudian klik
“Properties”.

2. Pada panel kanan, klik “change settings” yang berada di bagian “Computer name, domain,
and workgroup settings”.
f C=E=lE=a)

’ v[ » Control Panel » All Control Paneltems » System v “ Search Control Panel

Control Panel Home 4 i A
View basic information about your computer

@ Device Manager Windows edition
) Remote settings Windows 7 Professional
@ System protection Copyright © 2009 Microsoft Corporation. All rights reserved.

@ Advanced system settings Service Pack1
Get more features with a new edition of Windows 7

System

Rating: m Windows Experience Index

Processor: Intel(R) Core(TM) i5-3550 CPU @ 3.30GHz 3.30 GHz

Installed memory (RAM):  4.00 GB (3.33 GB usable) ’e'.m
System type: 32-bit Operating System

Pen and Touch: No Pen or Touch Input is available for this Display

Support Information

Computer name, domain, and workgroup settings
Computer name: TESPCSAKTI #)Change settings
Full computer name: TESPCSAKTLkemenkeu.go.id

Computer description: WPB0103G001
See also Domain: kemenkeu.go.id
Action Center

Windows activation

Windows Update J " 2
Windows is activated

Product ID: 00371-0OEM-8992671-00437

Performance Information and
Tools




3. Klik tab “Computer Name” dan kemudian klik “Change”.
' System Properties - u

Computer Name | Hardware I Advanced I System Protection I F{m‘lotel

ﬂ&: Windows uses the following information to identify your computer
= onthe network.

Computer description:
For example: "Kitchen Computer” or "Mary's 1
Computer”.
Full computer name: L ] |
Domain: O \

To use a wizard to join a domain or workaroup, click
Network ID. Network [D...

A ——
To rename this computer or change its domain or
warkgroup, click Change. e

[ ok ]| cancal || opy

4. lIsian “Computer name” tidak perlu diubah, sedangkan isian domain diganti dari
span.depkeu.go.id menjadi kemenkeu.go.id.

Computer Name/Domain Cha u‘

You can change the name and the membership of this
computer. Changes might affect access to netwark resources.
Mare information

Computer name:
KPBB402G10

Full computer name:
KP B 840210 kemenkeu go id

@ Domain:

kemenkeu . go.id

() Workgroup:

oK Cancel




5. Setelah mengisi komputer name dan domain sebagaimana gambar diatas, akan muncul
permintaan memasukkan username dan password. Masukkan username dan password akun
kemenkeu (dapat menggunakan akun kemenkeu siapapun).

Computer Name/Domain Changes

Enter the name and password of an account with permission to join the
domain.

— | [Username
‘E\ |F'asswc-rd

Domain: kemenkeu.go.id

6. Jika computer berhasil join domain, akan muncul notifikasi bahwa computer sudah berhasil
join domain yang diikuti dengan perintah untuk restart. Tekan tombol restart untuk merestart
komputer.

Microsoft Windows ‘

You must restart your computer to apply these
changes

Before restarting, save any open files and close all programs.

ﬂ | Restart Now ]Ml

7. Jika mengalami kendala melakukan migrasi domain komputer SPAN ke kemenkeu.go.id
dapat mengirimkan email ke hai.djpb@kemenkeu.go.id.




Lampiran 3: Panduan Pengaturan Internet Explorer dan Java Pada Komputer
SPAN Untuk Akses SPAN EBS

Setelah login ke Komputer SPAN dengan menggunakan akun domain, yang perlu

dilakukan adalah setting Internet Explorer dan Instal certificate Java. Yang perlu dilakukan
untuk setting Internet Explorer dan java adalah:

a.

~®o00T

Set home page Internet Explorer

Pengaturan security site https://core.span.depkeu.go.id
Matikan pop up blocker

Impor certificate “Pusintek Root CA”

Pengaturan “Compatibility Settings”

Instal Certificate Java

a. Setting Home Page Internet Explorer

Home page adalah halaman web yang langsung dibuka pada saat pertama Kkali

membuka browser. Pada komputer SPAN, home page disarankan untuk di set ke halaman

SPAN.
1.

Adapun caranya adalah sebagai berikut:
Buka browser internet explorer kemudian masuk ke menu tools -> Internet Options ->
General.

Pada isian “Home page” hapus isian yang ada kemudian ketikkan
https://core.span.depkeu.go.id:4444. Setelah itu, tekan tombol “OK”.
Internet Options I | i &5 J

g
General |5ec|..|ri1:yI I Privacy I Content I Connections I Programs I Advanced|

Home page
/’ To create home page tabs, type each address on its own line.
L y
1 about:blank

[ Use current ][ Use default ][ Use blank

Browsing history

"l_ . Delete temporary files, history, cookies, saved passwords,
) and web form information,

|| Delete browsing history on exit

Delete. .. ][ Settings ]

Search
(7}  Change search defaults.
4\f by i

Tabs

Change how webpages are displayed in
tabs,

Appearance

Colors ][ Languages ][ Fonts ][ Accessibility ]

[ OK ] [ Cancel ] [ Apply ]



https://core.span.depkeu.go.id:4444/OA_HTML/AppsLogin?langCode=IN

b. Pengaturan security site https://core.span.depkeu.go.id

Setelah berhasil masuk ke halaman desktop windows dengan akun login domain untuk
pertama kali, masing-masing user perlu memasukkan alamat url SPAN ke zone “trusted sites”
dan dan mengatur “security level for this zone” untuk “zone trusted sites” pada level “Medium-

”

Low” :
1. Buka browser internet explorer kemudian masuk ke menu tools -> Internet Options ->
Security.
2. Pilih Trusted Sites dan kemudian klik Sites sampai muncul tampilan sebagai berikut:
[~ Ez |

Trusted sites |

7 You can add and remove websites from this zone. All websites in

v this zone will use the zone's security settings.

Add this website to the zone:

Websites:

ral
Irl_-

=]

T

Require server verification (https:) for all sites in this zone

Close

3. Masukkan alamat https://core.span.depkeu.go.id di isian Add this website to the zone.
Jika sudah , klik tombol “add” dan kemudian close hingga kembali ke tampilan awal
browser.

4. Atur “security level for this zone” pada zone “trusted sites” pada level “Medium-Low”

sebagaimana dapat dilihat pada gambar dibawah ini:

\General Security | privacy | Content | Connections | Programs | Advanced |

Select a zone to view or change security settings.

@ & v O

Internet Localintranet  Trusted sikes  Restricted
stes

Trusted sites -
jtes
" This zone contains websites that you —I—

“%  trust not to damage your computer or
your Files,
¥ou have websites in this zone.

Sacurity level For this zone
fllowed levels For this zone: All

- | Medium-low

- Appropriate for websites on your local network
(intranet)

- Mast content will be run withaut promping you

- Unsigned Active contrals will not be downloaded
- Same as Medium lewel without prompts

I Enable protected Mode (requires restarting Internet Explarer)

Customevel,.. | Defaultlevel |

Reset all zones to default level

g cancel | Apply |

c. Mematikan Pop Up blocker


https://core.span.depkeu.go.if/

Pop Up blocker perlu dimatikan. Hal ini dikarenakan pop up blocker dapat memblokir
applet java yang muncul ketika membuka aplikasi SPAN. Adapun caranya adalah sebagai
berikut:

1. Masuk ke menu Internet Options. Caranya adalah dengan memilih menu Tools-Internet
Options hingga muncul menu “Internet Options”

2. Pada menu “Internet Options” pilih tab “Privacy” dan kemudian hilangkan tanda centang
pada check box “Turn-On Pop up Blocker” sebagaimana gambar dibawah ini.

‘ General | Security | Privacy |C0ntent | Connections I Programs | Advancedl ‘

Settings
c:u= Select a setting for the Internet zone.

Medium

- Blocks third-party cookies that do not have a compact

privacy policy

- Blocks third-party cookies that save information that can
(| be used to contact you without your explicit consent

- Restricts first-party cookies that save information that

can be used to contact you without your implicit consent

[ Sites I [ Impart I [ Advanced Default
Pop-up Blocker
1| Preventmost pop-up windows from Settings
- appearing.

[C1irarn on Pop-up Blocker:

InPrivate

/.\" [] Do not collect data for use by InPrivate Filtering

| Disable toolbars and extensions when InPrivate Browsing I
starts

oK ][ Cancel ][ Apply ]

d. Install Certificate “Pusintek Root CA 01”

Setelah berhasil masuk ke halaman desktop windows dengan akun login domain untuk
pertama kali, masing-masing user perlu melakukan instalasi Certificate Pusintek Root CA 01.
Instalasi ini perlu dilakukan meskipun sebelumnya di PC tersebut sudah terinstal Certificate
Pusintek Root CA 01 untuk user yang lain. Hal ini disebabkan masing-masing user mempunyai
setting internet explorer sendiri-sendiri. Adapun tata cara instalasinya adalah sebagai berikut:

1. Masukkan alamat SPAN https://core.span.depkeu.go.id:4444 di address bar. Saat pertama
masuk ke dalam interface aplikasi SPAN, apabila belum terinstal sertifikat maka akan
muncul tampilan seperti ini, klik Continue to this website (not recommended).



https://core.span.depkeu.go.id:4444/

File Edit View Favorites Tools Help
i Favortes |55~ 8 Certfcate Eror Navig... | £ Intemet Explorer cannot div. |

4
l@ There is a problem with this website's security certificate.

The security certificate presented by this website was not issued by a trusted certificate authority.
Security certificate problems may indicate an attempt to fool you or intercept any data you send to the server.

We recommend that you close this webpage and do not continue to this website.

@‘ Click here to close this webpage.

l @ Continue to this website (not recommended). l

© More information

2. Pada layar berikutnya akan terlihat halaman muka aplikasi span, namun dengan
peringatan Certificate error pada address bar, klik peringatan Certificate Error

File Edit View Favorites Tools Help

¢ Favorites |53 } - ‘ & Masuk x j (@ Internet Explorer cannot di... ‘ ‘

*Nama Pengguna

(contoh: michasljames.smith)

*Kata Sandi
(contoh: 4u99v23)
F Batalkan
Bantuan Masuk
Aksesibilitas Tanpa v

777

3. Akan muncul pop-up Untrusted Certificate, lalu klik pada View certificates:
QMasuk-Wmdows_Iqtemet plo

G- e

. File Edit View Favorites Tools Help

| 5. Favorites Eg - 1 € Masuk
l The security certificate presented by this

= '@ Untrusted Certificate

website was not issued by a trusted
certificate authority.

This problem might indicate an attempt to
fool you or intercept any data you send to
the server.

We recommend that you close this webpage.

About certificate errors
toh: michzel,james.smith)

toh: 4u99v23)
| Masuk || Batalkan !

Bantuan Masuk '

Aksesibilitas Tanpa v

&




4. Setelah link view Certificates di klik, akan muncul menu Certificate sebagaimana

gambar dibawah ini. Pilih tab Certification Path.
Certificate o {ij

3

General ‘ Details ICertiﬁcaﬁun Paihl I

@g Certificate Information

This certificate cannot be verified up to a trusted
certification authority.

Issued to: core.span.depkeu.go.id

Issued by: Pusintek External CA 01

valid from 21/ 08/ 2013 to 21/ 08/ 2023

Install Certificate...| | Issuer Statement

Learn more about certificates

5. Setelah tab view certificate di klik, akan muncul tampilan seperti dibawah ini. Pada
menu ini, pilih Pusintek Root CA 01 (path paling atas), lalu klik tombol View
Certificate.

—Certiﬁcate | = .|\

Certification Path

Certification path

Pusintek Root CA 01
+-izgl Pusintek External CA 01

[5] core.span.depkeu.go.id

View rﬁﬁr_ate

Certificate status:
’Tnis CA Root certificate is not trusted because itis notin the Trusted Root
Ct

ertification Authorities store.

Learn more about certification paths

6. Setelah tombol View Certificate di klik, akan muncul tampilan seperti dibawa ini. Klik
tombol Install Certificate.



Certificate (= .“

General | Details | Certification Path

4} Certificate Information

This CA Root certificate is not trusted. To enable trust,
install this certificate in the Trusted Root Certification
Authorities store.

Issued to: Pusintek Root CA 01

Issued by: Pusintek Root CA 01

valid from 25/ 01/ 2012 to 25/ 01/ 2037

Install Certificate. .. Issuer Statement

Learn more about certificates

7. Setelah tombol Install Certificate di klik, akan muncul kotak dialog Certificate Import

Wizard seperti dibawa ini. Ikuti wizard dengan menekan tombol next.
rCerliﬁcate Import Wizard l 23 J

Welcome to the Certificate Import
Wizard
This wizard helps you copy certificates, certificate trust

lists, and certificate revocation lists from your disk to a
certificate store.

A certificate, which is issued by a certification authority, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections. A certificate store is the system area where
certificates are kept.

To continue, dick Next.,

< Back [ MNext > ][ Cancel ]

8. Menentukan lokasi certificate akan disimpan. Pilih place all certicicates in the
following store. Kemudian klik tombol Browse dan pilih Trusted Root Certification
Authorities seperti gambar dibawah ini.



[ Certificate Import Wizard l - f!,‘r_;“:'gg—-

Certificate Store
Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can spedfy a location for
the certificate,

() Automatically select the certificate store based on the type of certificate
© Place all certificates in the folowng swrg
Certificate store: h
Select Certificate Store

Select the gertificate store you want to use,

1. Enterprise Trust
| Intermediate Certification Authorities
| Trusted Publishers
7 Uintrictad Cactificates
< | m

[”] show physical stores

|lox ll[cwel]

9. Setelah memilih folder penyimpanan certificate, akan muncul kotak dialog konfirmasi
impor certificate. Klik Finish untuk memberikan konfirmasi.
'CertiﬁmielmportWizald

Completing the Certificate Import
Wizard

The certificate will be imported after you dick Finish.

You have spedified the following settings:

Certificate Store Selected by User  Trusted Root Certifics
Content Certificate

4 L) L3

[ <@k || o )| concel |

10. Setelah memberikan persetujuan impor certificate, akan muncul kotak dialog konfirmasi
instalasi certificate. Klik Yes untuk memberikan konfirmasi persetujuan.



ey  aames

You are about to install a certificate from a certification authority (CA)
l % claiming to represent:

Pusintek Root CA 01

Windows cannot validate that the certificate is actually from “Pusintek
Root CA 01", You should confirm its origin by contacting "Pusintek
Root CADL". The following number will assist you in this process:

Thumbprint (shal): D7SED3EL 2F132FE4 34928830 C58TFFED S6975AT3

Warning: [é

If you install this root certificate, Windows will autornatically trust any
certificate issued by this CA. Installing a certificate with an unconfirmed
thumbprint is a security nisk. f you click "Yes" you acknowledge this

risk.

Do you want to install this certificate?

I Yes No

— 4

L.

11. Certificate Pusintek Root CA 01 sudah terinstal. Klik OK untuk memberikan konfirmasi.
Certificate Import Wizard 28

:I The import was successful,

|
. —

12. Restart IE, seharusnya peringatan error certification sudah tidak muncul.

e. Pengaturan “Compatibility Settings”
Agar dapat menampilkan site SPAN dengan baik, perlu pengaturan “Compatibility View

Setting”. Adapun caranya adalah sebagai berikut:

1. Tekan Tools pada “’Menu Bar”. Jika “Menu Bar” tidak muncul, tekan tombol “Alt” pada
keyboard untuk memunculkan “Menu Bar”. Kemudian pilih “Compatibility View Settings”
sebagaimana dapat dilihat pada gambar dibawah ini.



€ | http://proxy01.depkeu.go.id/?cfru=aHR0cDovl 3d3dy5tc24uY20tL20vY2IkPWilaH/

File Edit View Favorites lm! Help

i} Favorites ‘ @ Access Deni Delete Browsing History... Ctrl+Shift+Del
- InPrivate Browsing Ctrl+Shift+P

Diagnose Connection Problems...

Access Denied ( Reopen Last Browsing Session

y dential InPrivate Filtering Ctrl+Shift+F
o_ur»cre ?ntla St InPrivate Filtering Settings ]
This is typically cau L
Pop-up Blocker >
For assistance, contag SmartScreen Filter 4

Manage Add-ons

Compatibility View

l Compatibility View Settings l

Subscribe to this Feed...

Feed Discovery »
Windows Update

Developer Tools F12

Send to OneNote

Internet Options

2. Pada menu “Compatibility View Settings” centang pilihan “Display all websites in
Compatibility View”. Jika sudah, tekan tombol close.
e — ]

Compatibility View Settings i ——

[73;1 You can add and remove websites to be displayed in
A Compatibility View.

Add this website:

Websites you've added to Compatibility View: I

Remove |

Indude updated website lists from Microsoft
Display intranet sites in Compatibility View

| [//Display all websites in Compatbilty View! |

f. Impor Certificate Java Pada PC SPAN
Pesan peringatan “The application’s digital signature cannot be verified. Do you want to run the

application?” pada saat menjalankan applet java disebabkan certificate java belum terinstal.
Adapun cara instal certificate java untuk aplikasi SPAN adalah sebagai berikut:

1. Copy certificate java ke hard disk PC (download dari ftp://10.242.231.205 user : kppn
pass : P@sswOrd


ftp://10.242.231.205/

» TheInternet » 10.242.231.205 » InfraSPAN

AdobeReader

Petunjuk Pengetesan Printer Epson

01 panduan join demain span.docx

02 Panduan Setting Internet
Explorer Pada Komputer SPAN Un...

ChromeStandaloneSetup.rar

DLQ3500
2
205 L
w

i
:
(<)

IE9-Windows7-x86-enu.rar
scovery (E)
(F)

ail (\\Tespolicyspar

I~ ©anguan Pengaturan Intemet
Explorer dan Java Untuk Mengaks...

[ ror B

E ChromeStandaloneSetup64.rar

[ ror B

Certificate Pusintek Root CA

setting_pc_span

01 Panduan Reset [E Pada
Komputer SPAN.docx

02 Panduan Setting Internet

Explorer Pada Komputer SPAN Un...

java-6.81.rar

panduan penggunaan login
domain span.pdf

Chrome

WinRar

I - 01 Panduan Reset [E Pada
Komputer SPAN.pdf

EI = 04 Setting Java Pada Komputer
SPAN.pf

EIE '~ sfior permasalahan terkait

}., perangkat lunak pada kemputer S...

Java-T.A5.rar

ne (X

TCOstreamurar

2. Kiik start menu windows -> control panel -> java

)5 (B3 » Control Panel » All Control Paneltems » <4

Adjust your computer’s settings

P Action Center
g AutoPlay
{8l Click-to-Run Application Manager
ff Date and Time
@4 Device Manager
@ Ease of Access Center
JA Fonts
8 Indexing Options
Internet Options
% Lenovo - Factory Recovery Disks
@ Lenovo HD Audio Manager
‘% Lenovo's System Health and Diagno...
¥ Mouse
M Performance Information and Tools
B Power Manager
& Recovery
‘ Sound
™ System
8, User Accounts
i Windows Defender

) Administrative Tools

b Backup and Restore

| Color Management

e Default Programs

@ Devices and Printers

Flash Player

=4 Getting Started

el [ntel(R) Graphics and Media

Lenovo - Fingerprint Reader
@ Lenovo's Enhanced Backup and Rest...
Location and Other Sensors
5 Network and Sharing Center
Q Personalization

3 Power Options

& Region and Language

6 Speech Recognition

lak, Taskbar and Start Menu

& Windows Anytime Upgrade
P Windows Firewall

Trend Micro Officescan.rar

R

View by: Smallicons ¥

E Adobe Version Cue CS3
[2] Biometric Devices
Credential Manager
[ Desktop Gadgets
& Display
E Folder Options
& HomeGroup
B Intel® PROSet/Wireless Tools
&2 Keyboard
0 Lenovo - Update and Drivers
e Lenovo's Password Vault
D Mail
B3 Notification Area Icons
{5 Phone and Modem
ﬁ Programs and Features
5 RemoteApp and Desktop Connections
@ Sync Center
Troubleshooting
E Windows CardSpace
J';" Windows Update

L\ PETUNJUK UPDATE WINDOWS BC
SPAN docx

Search Control Panel Fe) |

v & Search InfraSPAN

PatchWindows
WinZip 11
-
02 Panduan Legin Dengan Akun
Domain pada Komputer SPAN.docx
E IE S.rar

[ ror B Panduan Mengatasi Permasalahan
Laporan PDF tidak Muncul Pada ...

" tata cara setting pe span kanwil
Kalsel.docx

3. Pada menu “Java Control Panel” pilih tab “security” dan kemudian tekan tombol

“Certificates...”



' GmerdlUpdahelJava|Semrity|Advm|

[~ Certificates
Use certificates to positively identify yourself, certifications, authorities, and

publishers.,
| Restore Security Prompts ]l[ Cgﬁﬁcanﬁ.._]

o] (o] [ o0 |

4. Pada menu “Certificates”, pilih “Trusted Certificates” pada dropdown “certificate type’

dan kemudian klik tombol “Import” untuk mencari file certificate java.
|

Certificate type: [ Trusted Certificates -]

User | system|

Issued To Issued By

r “Bport | [ Remove | [ Dewis | |
[
5. Masuk ke folder lokasi dimana file certificate java yang telah di copy pada langkah 1

berada. Pada dropdown “Files of type:” pilih “Allfiles”. Pilih sertificate java, kemudian klik

tombol “Open”.




Look in: {‘j. certificate root ca ‘W ‘, [,‘
-
i
Recent Items
Desktop
° B
My Documents
A
“
Computer
@ File name: |certificate java |
e 2

6. Setelah certificate java dipilih, maka akan muncul certificate java sebagaimana gambar
dibawah ini. Klik tombol “Close” dan certificate java sudah terinstal.

: [Trusted Certificates

Issued To Issued By
ORAPROD_dc1h206e02 ORAPROD_dc1h206e02

(Limport ) [ Eoort ][ Remove ][ petais |




Lampiran 3: Pengaturan Microsoft Excel Agar Dapat Menggunakan Tools
WebADI

webADI (web Application Desktop Integrator) merupakan salah satu alat bantu yang tersedia di
SPAN. Fitur ini merupakan fitur standar yang tersedia dari Oracle E-Business yang digunakan
sebagai salah satu cara untuk user mengentri data ke SPAN. WebADI banyak digunakan di
seksi Vera antara lain untuk melakukan input jurnal manual(penyesuaian awal tahun), jurnal
manual koreksi serta MPHLBJS. webADI sendiri menggunakan Microsoft Excel dengan fitur
macro yang harus diaktifkan agar dapat berjalan dengan baik. Adapun pengaturan Microsoft
Excel 2010 agar dapat menggunakan webADI adalah sebagai berikut:

1. Buka microsoft excel 2010, kemudian masuk ke menu File > Options. Tampiran menu Excel
Options dapat dilihat pada gambar dibawah ini.

= j General options for working with Excel.

Formulas
Proofing User Interface options
Save [7] Show Mini Toolbar on selection

(V] Enabile Lve Preview
Language e

Color scheme:  Sitver B
gk ScteenTip style: | Show feature descrigtions in ScreenTios |
Customize Ribbon

When creating new workbooks

Quick Atcess Toolbae

Use this fopt: Body Font E
Add-ng X

Font sige: u ]
Trust Cantey Default ylew for new sheets: Nomol View E

Include this many sheets: 3 =

Personalize your copy of Microsoft Office

User name: | myunaid

2. Pada menu Excel Options, pilih “Trust Center”.


http://1.bp.blogspot.com/-_23sZfihwzU/T7jm3ZTd13I/AAAAAAAAAFY/XCjA_Wled5Q/s1600/1.jpg

eot @ Help keep your documents safe and your computer secure and healthy,
Formulas
Prooting Protecting your privacy
Save Micrasoft cares about your privacy. For more about how Excel helps to protect your privacy, please
See the Privacy statements.
tanguage
Shoyy the Microzoft Excel privacy statement
Advanced Difice.com provacy statement
Customize Ribbon
Quick Access Toolbae Securtty & more
Adddnt Learn more about protecting your privacy and security from Office.com.
Muicroson Trystworthy Computing
| Trust Center. |
Microsoft Exced Trust Center
The Trust Center contains security and privacy settings. These settings help keep your
secure, We that you do not change these settings. !!:!: _‘.__

3. Setelah memilih memilih “trust center”, tekan tombol “Trust center settings...”

i r

Trusted Pubiishers - Bar Seltings for all Office Appiicath

Trusted Locatio
i Showsng the Message Bar
Trusted Documents © Show the Message Bar in all applications when active content, such a5 ActiveX controls and macros, has been
blocked

Add-ins ) Never show informstion about blocked content

1] Enable Trust Center logging
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4. Pilih “ActiveX Settings” dan pilih radio button “Enable all control without ....... ” Sebagaimana
dapat dilihat pada gambar.

Trust.
Truted Fuokihiocs ActiveX Settings for all Office Applications
Teusted Location s
) Disable all controls without notification
Teusted Documents ) Prompt me before g Unsafe for (UFD controls with addtional restrictions and Safe for
Adddns Initiahzation (SFT) controls with sumimal restrictions
) Prompt me befoce enabling all controks with minimal restrictions
lmm © Enable all controls without restrictions and without p (not dang controls
Macro Settings e
Protected View 71 5ate mode Melps kit the control's access 1o your computer)
Message Bar
External Content:
‘l File Block Settangt
Privacy Options
I
5. Pilih menu “Macro Settings”. Pada pilihan “Macro setting” pilih radio button “Enable all
macros ........ ” dan centang check box “Trus access to the VBA ....”

Macro Settings
) Dissble 3% macros without notification
Wriasted Docaints ) Disable 38 macros with notification

Add-int ) Disable 3% macros encept digitally signed macrors
© Enable all macros (not

Trutted Locationt

Adtvex Settings

‘ Macro Settings ' Developer Macro Settings

Broteded View Trust access to the YBA project object model

Meisage Bar
Externat Content
File Block Settings
Privacy Options
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6. Pilih menu “Protected View” dan pastikan tidak ada check box yang tercentang.

> PP £
Trust Center i
| "
rusted Publishers
Eated caions Protected View opens potentislly dangerous files, without sny securty prompts, in 8 restricted mo-de to heip minumize harm
Trusted Documents to your By 9 View you could be your to secunty threass.
1] Enable Protected View for files originating from the Internet

. 7] Enabie Protected View for files Focated in potentially unsafe locations: )
ActiveX Settings [7] Enable Protected View for Outinok attachments
Macro Settings Data Execution Prevention

| ProtecteaView || 7] nabte Dats Execution Prevention mode ()
Message Bar

External Content
File Block Settings
Privacy Options.

7. Pilih menu “External Contents” dan pilih radio button “Enable all data ....” Dan “Prompt user

on automatic ...... .

Teusted Publishers Security settings 1o Data Connections
Trusted Locations

© Enabie all Data C; (not
Trusted Documents ) Prompt user sbout Data Connections
Adddns ) Risable all Dats Connections.
ActiveX Settings Security settings for Workbook Links
Macro Settngs

) Enable gutomatic update f'or all Workbook Links inct recommended)
Protected View © Prompt user on sutomatic update for Workbook Links
1) Disable automatic update of Workbook Links

(o) [come ]

8. Tekan OK sampai kembali ke menu awal.
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Lampiran 4: Update Windows

1. Masuk ke menu Windows Update dengan menekan tombol start menu -> Control Panel
2. Pilih Windows Explorer. Pastikan pilihan view by: adalah Small icons

=1
T o [seomCom ]
Adjust your computer’s settings
[ Configuration Manager & Credential Manager (27 Uate and lime N
@ Default Programs % Desktop Gadgets &3 Device Manager
% Devices and Printers B Dicplay @ Ease of Access Center
Flash Player Folder Options la Fonts
=l Getting Started ﬁ HomeGroup & Indexing Opticns
B Intel(R) Graphics and Media B Intel® PROSet/Wireless Taals &2 Intel® Rapid Storage Technology
Internet Options &= Keyboard g{;‘ Lenovo - Factory Recovery Disks
@ Lenovo - Fingerprint Reader @ Lenovo - System Health and Diagno... @ Lenovo - Update and Drivers
@ Lenove - Web Conferencing @ Lenovo HD Audic Manager li-: Lenovo View Management Utility
) Lenovo's SimpleTap Location and Other Sensars B Mail
@ Messages From Lenovo P Mouse '1:: Network and Sharing Center s
2 Notification Arealcons M Performance Information and Tools E_'l Personalization [
Phene and Modemn o Power Manager 9 Power Options
Programs and Features @ RapidBoat HOD Accelerator i Recovery
9 Region and Language @ RemoteApp and Desktop Connections 4 Sound
lél Speech Recognition @ Syne Center 1B System
u_ Taskbar and Start Menu Troubleshooting % User Accounts
£ Windows Anytime Upgrade B Windows Cardspace i \Windows Defender
P Windows Firewall @ Windows Live Language Setting @ Windows Update <

3. Kiik “Check for updates” dan ikuti perintah selanjutnya. Jika mengalami kegagalan, dapat di
retry kembali.

m ] » Control Panel » Al Control Panel lterms » Windows Update - Search Control Panel o

Control Panel Home

Check for updates

Change settings

Windows Update

e - .
View update history i Windows is up to date

There are no updates available for your computer.
Restore hidden updates

Updates: frequently asked

questions Most recent check for updates:  Today at %:33 AM
Updates were installed: 6/21/2018 at 8:11 AM. View update history
You receive updates: Managed by your system administrator

Check online for updates from Microsoft Update

Seealso
Installed Updates
E_. Windows Anytime Upgrade

4. Jika mengalami kendala melakukan update windows dapat mengirimkan email ke
hai.djpb@kemenkeu.go.id.



